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Important User Information
Because of the variety of uses for the products described in this publication, those responsible for the application and use of this control 
equipment must satisfy themselves that all necessary steps have been taken to assure that each application and use meets all performance 
and safety requirements, including any applicable laws, regulations, codes and standards.

The illustrations, charts, sample programs and layout examples shown in this guide are intended solely for purposes of example. Since there 
are many variables and requirements associated with any particular installation, Allen-Bradley does not assume responsibility or liability (to 
include intellectual property liability) for actual use based upon the examples shown in this publication.

Allen-Bradley publication SGI-1.1, Safety Guidelines for the Application, Installation and Maintenance of Solid-State Control (available from 
your local Allen-Bradley office), describes some important differences between solid-state equipment and electromechanical devices that 
should be taken into consideration when applying products such as those described in this publication.

Reproduction of the contents of this copyrighted publication, in whole or part, without written permission of Rockwell Automation, is 
prohibited.

Throughout this manual we use notes to make you aware of safety considerations:

Attention statements help you to:

 identify a hazard

 avoid a hazard

 recognize the consequences

Allen-Bradley is a trademark of Rockwell Automation. Windows is a trademark of the Microsoft Corporation.

ATTENTION: Identifies information about practices or 
circumstances that can lead to personal injury or death, property 
damage or economic loss

IMPORTANT Identifies information that is critical for successful 
application and understanding of the product.
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Preface

Overview of this Manual This manual describes how to use components of the Allen–Bradley Plotter Kit 
to create and print markers for Bulletin 1492 Terminal Blocks and accessories.

The following table describes the contents of this manual.
™

Note:  Refer to the ClearTools™  Software Manual for software installation 
and setup.

Chapter Title Contents

Preface Provides an overview of the manual.

1 Marking System Description Provides a brief overview of the hardware 
and software. Includes a description of 
system accessories.

3 Operation of Plotter Describes plotter controls.

2 Initial Setup Describes initial plotter setup.

4 Troubleshooting and 
Maintenance

Provides assistance in identifying and 
correcting common operating problems. 
Procedures for routine maintenance items 
are also provided.

At the end of its life, this equipment should be 
collected separately from any unsorted municipal waste
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Preface

Intended Audience Basic knowledge of the Microsoft Windows™ Operating System is required to 
operate the 1492-PLTKIT Plotter System. For ClearTools software instructions, 
refer to the user’s manual contained within the ClearTools software.

Conventions This manual uses the following conventions:
· Allen–Bradley Marking System software is referred to as ClearTools.
· Marker refers to the individual tabs that snap onto a terminal block.

· A marker card is a set of multiple markers. See Table 1.A for more 
information on marker cards.

Terminal Block

Marker

One
Marker
Card

One 
Branch

One
Marker



Chapter1

Marking System Description

Chapter Objectives This chapter describes:

 Marking System components

 Marker Cards

 Marker types

 Accessories

Marking System 
Components

The Terminal Block Marking System kit (Catalog No. 1492–PLTKIT) 
includes:

 Allen–Bradley Marking System (ClearTools) Software

 Plotter 

 Base Plate*

 Stainless-Steel Inlay (5)

 Disposable Pen

 USB Cable (connects personal computer to plotter)

 Power Cable

 Plotter User Manual (this document)

 220V Adapter

In addition, you need:

 Personal computer

 Marker Cards (See Table 1.A)

* A special plate, 1492-PLOTPLTA, is needed for the following markers: 1492-MW5-21, 1492-MW6-21, 
1492-MW7-21).

Personal Computer

ClearTools
Software

Inlay

Plotter

Base Plate
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Marker Cards Allen–Bradley markers can be printed in either a horizontal or vertical 
direction. The ClearTools software displays a view of the markers as they 
would appear on the plotter.  

Plotting always starts in the upper left corner of the marker card.

The plotter base plate has spaces for 5 marker cards. Spaces are numbered 1 to 
5, from left to right.

 

The inlay may be installed in the base plate at different heights by lining up the 
number (1 to 5) of the inlay with the red locating rib of a given space.

TB

G
N

D

TB
1

TB
2

TBGND TB1 TB2GNDGND

Plotting starts
here

TB G
N

D

TB
1

TB
2

TB GNDTB1TB2 GND GND

Horizontal Direction

Vertical Direction

Horizontal 
Upside-Down

Direction

Vertical 
Upside-Down

Direction

Inlay

Base
Plate

Plotter

Pen Station

1
2

3
4

5

Control
Panel

Writing
Arm
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Marker Types The marking system supports a variety of marker types.

Table 1.A 
Allen–Bradley Markers for Allen-Bradley Products

Marker/Label
Catalog No.

Use With These Allen-Bradley Terminal Blocks and Other 
Products

1492-M3X12 1492-L2, 1492-L2T, 1492-L2Q,1492-LD2, 1492-LD2C, 1492-LG2, 
1492-LG2T, 1492-LG2Q, 1492-LDG2, 1492-LDG2C

1492-M3X5 1492-L2, 1492-L2T, 1492-L2Q, 1492-LD2, 1492-LD2C, 1492-LG2, 
1492-LG2T, 1492-LG2Q, 1492-LDG2, 1492-LDG2C, 1738-OB16EM12, 
1738-OB16E25DS, 1738-OB16E19M23, 1738-IB16DM12

1492–M5X5 1492-CPL, 1492-FPK2…, 1492-J3, 1492-J10, 1492-J16, 1492-J35, 
1492-J50, 1492-J70, 1492-JD3, 1492-J2Q, 1492-J3TW, 1492-JD3C, 
1492-J3F, 1492-JD3F, 1492-JG2Q, 1492-JG3, 1492-JG3TW, 
1492-JDG3, 1492-JDG3C, 1492-JKD3, 1492-JKD3TP, 1492-J3P, 
1492-J3PTP, 1492-JD3P, 1492-JD3PTP, 1492-JD3PSS, 1492-JD3PSSTP, 
1492-JDG3P, 1492-JDG3PTP, 1492-JDG3PSS, 1492-JDG3PSSTP, 
1492-JD3DF*, 1492-JD3DR*, 1492-JD3RB*, 1492-JD3RC001, 
1492-JD3SS, 1492-JTC3*, 1492-JC3, 1492-JDC3, 1492-LMJ3, 
1492-LMJG3, 1492-LM3, 1492-LM3Q, 1492-LMG3, 1492-LMP3, 
1492-LMP3Q, 1492-L3, 1492-L3T, 1492-L3Q, 1492-LD3, 1492-L3QS, 
1492-LTF3, 1492-LD3C, 1492-LS2-3, 1492-LS2-3L, 1492-LSG2-3, 
1492-LS2-4, 1492-LS2-4L, 1492-LSG2-4, 1492-LG3, 1492-LG3T, 
1492-LG3Q, 1492-LDG3, 1492-LDG3C, 1492-LKD3, 1492-L3P, 
1492-LDG3P,1492-LDAG3, 1492-LC3, 1492-LCDC3, 1492-FB* Fuse 
Blocks

1492–M5X8 1492-JD3, 1492-JD3C, 1492-JD3F, 1492-JDG3, 1492-JDG3C, 
1492-JD3DF*, 1492-JD3DR*, 1492-JD3RB*, 1492-JD3RC001, 
1492-JD3SS

1492–M5X10 1492-ERL35, 1492-LM3Q, 1492-LMG3, 1492-LMJ3, 1492-LMJG3, 
1492-LMP3, 1492-LMP3Q, 1492-L3, 1492-L3T, 1492-L3Q, 1492-LD3, 
1492-L3QS, 1492-LD3C, 1492-LG3, 1492-LG3T, 1492-LG3Q, 
1492-LDG3, 1492-LDG3C, 1492-LKD3, 1492-L3P, 1492-LC3, 
1492-LDC3, Bulletin 931 Signal Conditioners, 1492-JD3P, 
1492-LM3, 1492-LDG3P, 1492-LDAG3

1492–M5X12 1492-J3F, 1492-JG2Q, 1492-JG3, 1492-JG3TW, 1492-JKD3, 
1492-JKD3TP, 1492-J3P, 1492-J3PTP, 1492-JTC3*, 1492-JC3, 
1492-JDC3, 1492-J3, 1492-J2Q, 1492-J3TW

1492-M5X15 1492-ERL15, 1492-LMP3Q

1492-M5X30 1492-WGB5

1492-M6X5 1492-EAJ15, 1492-J4, 1492-JG4, 1492-L4, 1492-L4T, 1492-L4Q, 
1492-LD4, 1492-LD4C, 1492-LG4, 1492-LG4T, 1492-LG4Q, 1492-LDG4, 
1492-LDG4C, 1492-LD4DF, 1492-LD4DR, 1492-LD4RB*, 1492-LD4SS, 
1492-J4M

1492-M6X10 1492-L4, 1492-L4T, 1492-L4Q, 1492-LD4, 1492-LD4C, 1492-LG4, 
1492-LG4T, 1492-LG4Q, 1492-LDG4, 1492-LDG4C, 1492-LD4DF, 
1492-LD4DR, 1492-LD4RB*, 1492-LD4SS, Bulletin 931 Signal 
Condioners

1492-M6X12 1492-J4, 1492-JG4, 1492-J4M, 1492-L6, 1492-L6T, 1492-L10, 
1492-LG6, 1492-LG6T, 1492-LG10, 1492-EAJ35
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1492-M7X12 1492-EAJ35, 1492-EAHJ35, 1492-H4, 1492-H5, 1492-H6, 1492-H7, 
1492-J6, 1492-J10, 1492-J16, 1492-J35, 1492-J50, 1492-J70, 
1492-J120, 1492-JG6, 1492-JG10, 1492-JG16, 1492-JG35, 
1492-JG50, 1492-JG70, 1492-JG120, 1492-L16, 1492-L16D, 1492-L35, 
1492-LG16, 1492-LG35

1492-M8X5 1492-J6, 1492-J10, 1492-J16,1492-J35,1492-J50,1492-J70, 
1492-JG6,   1492-JG10, 1492-JG16, 1492-JG35, 1492-JG50, 
1492-JG70, 1492-L6, 1492-L6T, 1492-L10, 1492-L16, 1492-L16D, 
1492-L35, 1492-LG6, 1492-LG6T, 1492-LG10, 1492-LG16, 1492-LG35

1492-MR5X8 1492-J3, 1492-JD3, 1492-JD3C, 1492-JD3F, 1492-JDG3, 
1492-JDG3C, 1492-JD3DF*, 1492-JD3DR*, 1492-JD3RB*, 
1492-JD3RC001, 1492-JD3SS, 1492-L3

1492-MR6X8 1492-J4, 1492-J4M, 1492JG4, 1492-L4T,  1492-L4Q,  1492-LD4 
1492-LD4C, 1492-LG4, 1492-LG4T, 1492-LG4Q, 1492-LDG4, 
1492-LDG4C, 1492-LD4DF, 1492-LD4DR, 1492-LD4RB*, 
1492-LD4SS, 1492-L6, 1492-L6T, 1492-L10, 1492-LG6, 1492-LG6T, 
1492-LG10, 1492-EAJ35

1492–MR5X10 1492-ERL35, 1492-LM3Q, 1492-LMG3, 1492-LMJ3, 1492-LMJG3, 
1492-LMP3, 1492-LMP3Q, 1492-L3, 1492-L3T, 1492-L3Q, 1492-LD3, 
1492-L3QS, 1492-LD3C, 1492-LG3, 1492-LG3T, 1492-LG3Q, 
1492-LDG3, 1492-LDG3C, 1492-LKD3, 1492-L3P, 1492-LC3, 
1492-LDC3, Bulletin 931 Signal Conditioners, 1492-JD3P, 
1492-LM3, 1492-LDG3P, 1492-LDAG3

1492-MR5X12 1492-J2Q, 1492-J3, 1492-J3TW, 1492-J3F, 1492-JG2Q, 1492-JG3, 
1492-JG3TW, 1492-JKD3, 1492-JKD3TP, 1492-J3P, 1492-J3PTP, 
1492-JTC3*, 1492-JC3, 1492-JDC3

1492-MR6X12 1492-J4, 1492-JG4, 1492-J4M,1492-L6T, 1492-L10, 1492-LG6, 
1492-LG6T, 1492-LG10 

1492-MR8X12 1492-J6, 1492-J10, 1492-J16, 1492-J35, 1492-J50, 1492-J70, 
1492-J120, 1492-J240, 1492-JG10, 1492-JG16, 1492-JG35, 
1492-JG50, 1492-JG70, 1492-JG120,1492-L6, 1492-L6T, 1492-L10, 
1492-L16, 1492-L16D, 1492-L35, 1492-LG6, 1492-LG6T, 1492-LG10, 
1492-LG16, 1492-LG35

1492-MC4X5 Some terminal blocks from Murr and Phoenix Contact

1492-MC5X5 Some terminal blocks from Murr and Phoenix Contact

1492-MC6X5 1492-FB* fuse blocks, some terminal blocks from Murr and Phoenix 
Contact

1492-MC7X5 Some terminal blocks from Phoenix Contact

1492-MC5X4 Some terminal blocks from Phoenix Contact

1492-MC5X8 Some terminal blocks from Entrelec, Phoenix Contact, Telemecanique, 
Wieland

1492-MC5X10 Some terminal blocks from Entrelec, Phoenix Contact, Telemecanique, 
Wieland

1492-MC5X12 Some terminal blocks from Entrelec, Phoenix Contact, Telemecanique, 
Wieland

Table 1.A 
Allen–Bradley Markers for Allen-Bradley Products

Marker/Label
Catalog No.

Use With These Allen-Bradley Terminal Blocks and Other 
Products
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1492-MC6X10 Bulletin 700-HL relays, Some terminal blocks from Entrelec, Phoenix 
Contact, Telemecanique, Wieland

1492-MC8X10 Bulletin 700-HL relays, Some terminal blocks from Entrelec, Phoenix 
Contact, Telemecanique, Wago, Wieland

1492-MCS7X10 Some terminal blocks from Siemens

1492-MCS5X10 Some terminal blocks from Siemens

1492-MCS6X10 Some terminal blocks from Siemens

1492-MCS7X7 Some terminal blocks from Siemens

1492-MCS5X8 Some terminal blocks from Siemens

1492-MCS6X8 Some terminal blocks from Siemens

1492-MCW4X9 Some terminal blocks from Murr and Wago

1492-MCW5X9 Some terminal blocks from Murr and Wago

1492-MCW5X9F Some terminal blocks from Murr and Wago

1492-MCW5X5 Some terminal blocks from Murr and Wago

1492-MCW6X9 Some terminal blocks from Murr and Wago

1492-MH5X10 1492-L3, 1492-L3T, 1492-L3Q, 1492-L3QS, 1492-LG3, 1492-LG3T, 
1492-LG3Q, 1492-LC3, 1492-LMJ3, 1492-LMJG3, 1492-LM3Q, 
1492-LMG3, 1492-LMP3, 1492-LMP3Q

1492-MH5X15 1492-L3,1492-L3T, 1492-L3Q 1492-L10, 1492-L16, 1492-L16D, 
1492-L35, 1492-LG3, 1492-LG3T, 1492-LG3Q, 1492-LG10, 1492-LG16, 
1492-LG35

1492-MH6X12 1492-L4, 1492-L4T, 1492-L4Q, 1492-L6, 1492-L6T, 1492-LG4, 
1492-LG4T, 1492-LG4Q, 1492-LG6, 1492-LG6T

1492-MN81 1492-HM1, 1492-HM2, 1492-HM3, 1492-CB*

1492-MN83 1492-CB*, 1492-HM3

1492-MAS9X17 Any equipment (self-adhesive)

1492-MAS6X15 Bulletin 700 relays, any equipment (self-adhesive)

1492-MAS9X11 1760-Pico, any equipment (self-adhesive)

1492-MS5X5 1492-WM3, 1492-WMD1

1492-MS5X9 1492-WR3, 1492-WTF3*, 1492-WTS3*, 700-HA, Bulletin 800F 
contact blocks

1492-MS5X12 1492-W3, 700-HA

1492-MS6X9 1492-RFB4*, 1492-RAFB4*, 1492-WM4, 1492-WMG4, 1492-W4TW, 
700-HA

1492-MS6X12 1492-W4, 1492-W6, 1492-W10 1492-W16S, 1492-WG4, 1492-WG6, 
1492-WG10S, 1492-WG16S, 700-HA

1492-MS8X9 700-HA, 1492-H4, 1492-H5, 1492-H6, 1492-H7, 1492-WFB4*

Table 1.A 
Allen–Bradley Markers for Allen-Bradley Products

Marker/Label
Catalog No.

Use With These Allen-Bradley Terminal Blocks and Other 
Products
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➊ Catalog numbers in bold indicate the preferred marker.
➋ Catalog numbers in italics indicate the corner markers of a spring-clamp terminal block.
➌ Many bulletin number 1492-M markers have identical mounting feet, resulting in the ability to use 

many different types of markers in a given product.

ClearTools Software ClearTools software is a Microsoft Windows-based program that creates files 
containing marker card layouts. These files contain all the information to print 
multiple base plates full of marker cards. See Table 1.B lists the available 
marking system accessories.

1492-MS8X12 1492-H4, 1492-H5, 1492-H6, 1492-H7, 1492-RFB4*, 1492-RAFB4*, 
1492-W10, 1492-WFB4*, 700-HA, 1492-W165, 1492-WG10, 
1492-WG165

1492-MS8X17 700-HN204, 700-HN205

1492-MS9X20 1667 PanelConnect

1492-MS10X17 100-C, 100-D, 700-CF, 140, 193-E1, 193-E3, 1492-REC*

1492-MW9X24 Wire/cable from 6 AWG (from 16.0 mm2)

1492-MW10X23 Wire/cable from 6 AWG (from 16.0 mm2)

1492-MW14X23 Wire/cable from 6 AWG (from 16.0 mm2)

1492-MW11X60 Wire/cable from 6 AWG (from 16.0 mm2)

1492-MW5-21 #12…10 AWG (4.0…6.0 mm2) wire

1492-MW6-21 #10…8 AWG (6.0…10.0 mm2) wire

1492-MW7-21 #8…6 AWG (10.0…16.0 mm2) wire

1492-MWC1-21 #20…18 AWG (0.5…1.0 mm2) wire

1492-MWC3-21 #18…14 AWG (0.75…2.5 mm2) wire

1492-MWC4-21 #12 AWG (2.5…4.0 mm2) wire

1492-MWC1-12 #20...18 AWG (0.5…1.0 mm2) wire

1492-MWC3-12 #18…14 AWG (0.75…2.5 mm2) wire

1492-MWC4-12 #12 AWG (2.5…4.0 mm2) wire

1492-SM5X10 1492-JD3P, 1492-JD3PTP, 1492-JD3PSS, 1492-JD3PSSTP, 
1492-JDG3P, 1492-JDG3PTP, 1492-JDG3PSS, 1492-JDG3PSSTP

1492-M5X30 1492-GMC

1492-MD6X9 1732 I/O

Table 1.A 
Allen–Bradley Markers for Allen-Bradley Products

Marker/Label
Catalog No.

Use With These Allen-Bradley Terminal Blocks and Other 
Products
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Accessories

➊ Recommended when plotting 12-point font or larger.
➋ The latest software can be downloaded at: www.ab.com/industrialcontrols/products. Select 

Connection Devices > Terminal Blocks > Marking Solutions > X-Y Plotter Marking System > 
Software

Table 1.B  Accessories

Item Catalog No. Description   

Disposable Pen 1492–PLOTPEN25 Disposable ink pen with 0.25 
mm tip

Disposable Pen 1492–PLOTPEN35 Disposable ink pen with 0.35 
mm tip

Pen Adapter 1492-PLOTADPT Pen adapter for use with Sharpie™ 
Ultra Fine Point Pen ➊

Pen Station Service Kit ➋ 1492–PLOTSERV Pen Station Service Kit for 
replacing pen priming tabs and 
ink-coated pen sealing units

Base Plate 1492-PLOTPLT Base plate for the plotter

Plotter Software ➋              — CD of ClearTools Software

Single Plate 1492-PLOTPLTA Single plate used with wire 
markers (not included in plotter kit)

IMPORTANT It is important to only use the above accessories with the 
plotter. Use of other accessories may damage the plotter.
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Table 1.C Inlay Spacer Settings

Marker Card Inlay Position Number

1492-M3X5 3

1492-M3X12 2

1492-M5X5 3

1492-M5X8 2

1492-M5X10 2

1492-M5X12 2

1492-M5X15 2

1492-M5X30 3

1492-M6X5 3

1492-M6X10 2

1492-M6X12 2

1492-M7X12 2

1492-M8X5 3

1492-MAS6X15 5

1492-MAS9X11 5

1492-MAS9X17 5

1492-MC4X5 4

1492-MC5X4 2

1492-MC5X5 4

1492-MC5X8 1

1492-MC5X10 1

1492-MC5X12 1

1492-MC6X5 4

1492-MC6X10 1

1492-MC7X5 2

1492-MC8X10 1

1492-MCS5X8 3

1492-MCS5X10 3

1492-MCS6X8 3

1492-MCS6X10 3

1492-MCS7X7 3

1492-MCS7X10 3

1492-MCW4X9 4

1492-MCW5X5 4

1492-MCW5X9 4
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1492-MCW5X9F 3

1492-MCW6X9 4

1492-MH5X10 6

1492-MH5X15 6

1492-MH6X12 6

1492-MN81 1

1492-MN83 1

1492-MR5X8 2

1492-MR5X10 2

1492-MR5X12 2

1492-MR6X8 2

1492-MR6X12 2

1492-MR8X12 2

1492-MS5X5 2

1492-MS5X9 1

1492-MS5X12 6

1492-MS6X9 1

1492-MS6X12 1

1492-MS8X9 1

1492-MS8X12 1

1492-MS8X17 2

1492-MS9X20 2

1492-MS10X17 3

1492-MW9X24 5

1492-MW10X23 5

1492-MW11X60 5

1492-MW14X23 5

1492-MWC1-12 1

1492-MWC1-21 1

1492-MWC3-12 1

1492-MWC3-21 1

1492-MWC4-12 1

1492-MWC4-21 1

1492-SM5X10 2

1492-SM6X10 2

1492-MD6X9 3

Table 1.C Inlay Spacer Settings

Marker Card Inlay Position Number
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1. Line up the number on the inlay with the notched locator on the base 
plate.

2. Slide right side of marker card under ledge on plotter plate.

3. Line-up first notch on the left side of the marker card to the notch on 
the plotter plate. 

4. Press the left side on the marker card down on to the plotter plates. For 
plotter plates with the adhesive strip, refer to Adhesive Strip Preparation 
on page A-1.

Installing Inlay onto Plate Installing Marker Card onto Plate

Table 1.D Inlay Spacer Requirement Using Special Plate, 1492-PLOTPLTA

Marker Card Inlay

1492-MW5-21 Inlay needed

1492-MW6-21 No inlay needed

1492-MW7-21 No inlay needed



Chapter 2

Initial Setup

Chapter Objectives This chapter shows how to:

• Set up the Plotter

• Installing the Plotter Driver

• Activating the Plotter with ClearTools

Setup Location
A dry, dust-free room is the ideal environment for the plotter. If possible, do 
not install the device in damp or very dusty areas. Do not expose the system to 
direct sunlight. Please ensure the connections on the right-hand side of the 
device are accessible all times. Position the plotter firmly on the work surface 
where it is to be used, ensuring it is level. Please ensure the writing arm can 
move freely and is not obstructed by other objects.

Connections

1. Install the power cord and plug into outlet.

The plotter power supply features a variable AC input voltage of 100 to 
240V AC/50...60 Hz. The power connection can be replaced by way of 
adapter plugs, as required.

2. Connect the plotter to the computer using the USB cable. The USB port 
is located on the right-hand side of the plotter.
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Installing the Plotter Driver

Installing the driver for the 
plotter 1492-PLTKIT Series E 
within Windows 2000

1. Login into your Computer using an account with administrative rights.

2. Connect the Plotter to your system and switch on the power.
The “Found New Hardware Wizard” starts. Click on “Next”.

3. Choose “Search for a suitable driver for my device (recommended)” 
and then click “Next”.
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4. Choose “Specify a location” and click on “Next”.

5. In the opening window, click on “Browse” and select the subfolder 
“W2K” in the folder “Psetup” on your installation CD. Confirm with 
“Open” and then with “OK”.

6. Then click on “NEXT“. The installation begins now. 
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7. During the installation a message appears stating “The software you 
are about to install does not contain a Microsoft digital 
signature… ” and asks “Do you want to continue the installation?” 
Click on “Yes”.
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8. Click on “Finish” to close the window.

The driver for the connected device 1492-PLTKIT Series E is now installed 
and ready to use.
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Installing the driver for the 
1492-PLTKIT Series E  within 
Windows Vista

1. Login into your Computer using an account with administrative rights.

Before you begin installing the driver you need to know if you are running the 
32-bit or the 64-bit version of Windows Vista on your computer. If you are not 
sure, you can open the following window:
 
Start > Control Panel > System and Maintenance > System 
or Start > Control Panel > System (when using the classical view of the 
control panel). 

Within the line “System type” you can find the information needed.
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2. Go to “Start > Control Panel > Printers”. Then connect your 1492-PLTKIT 

Series E  plotter to the system and switch on the power. If the driver is already 
installed, you will find your plotter in the list of Printers and Faxes.

If the driver is not yet installed, the window “Found New Hardware” 
appears.
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Click on ”Locate and install driver (recommended)”.

3. If a window appears, asking “Allow windows to search online....?” 
answer with “Don't search online”.

4. After the following window appears, insert the installation CD into the drive 
and click on “Next”.
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5. The recognized drivers on the CD are listed.

Choose the entry …\Psetup\vista_64\1492_pltkit.inf (for the 64-Bit 
version of Windows Vista). or …\Psetup\vista_32\1492_pltkit.inf 
(for the 32-Bit version of Windows Vista) and click on “Next“, to start 
the installation.

If this list does NOT appear (or you have stored the driver files at a different 
location on your computer), you can search for the driver files manually.

6.1. Click on “I don't have the disk. Show me other options.” (in the 
window shown above)

6.2. Choose “browse my computer for driver software (advanced)”
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Click on “Browse” and select the path Psetup\vista_32 or Psetup\vista-64, 
depending on whether you have a 32-bit or 64-bit version of Windows Vista. 
(In order to see which Windows Vista version you have, navigate to Start > 
Control Panel > System and Maintenance > System  or Start > Control 
Panel > System.)
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Confirm with “OK” and then “Next”. The installation starts now.

7. During the installation the following message appears:
“Windows can't verify the publisher of this driver software”:

Choose “Install the driver software anyway”.

8. After a successful installation Windows issues the following message. 
Press click on “Close” to complete the installation.

9. Reopen the window “Control Panel > Printers”. Your plotter should 
now appear in the list of Printers and Faxes.
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Installing the driver for the 
1492-PLTKIT Series E within 
Windows XP

1. Login into your Computer using an account with administrative rights.

2. Connect the Plotter to your system and switch on the power.
The “Found New Hardware Wizard” starts.

3. Choose “Install from a list or specific location” and then click 
“Next”.

4. In the next window, choose “Search for the best driver in these 
locations” and check the box “Include this location in the search”, 
click on “Browse” and select the subfolder “XP” in the folder 
“Psetup” on your installation CD. Confirm with “OK” and then with 
“Next”. 
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The driver will now be installed. During the installation the following 
message appears: 
“The software you are installing for this hardware: … has not 
passed Windows Logo testing…”.

5.  Choose “Continue Anyway” and wait until the installation is 
completed. This can take about one minute.

6. Click on “Finish” to close the window.

The driver for the connected plotter 1492-PLTKIT Series E is now 
installed and can be used.
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Installing the driver for the 
1492-PLTKIT Series E  
within Windows 7

1. Login into your Computer using an account with administrative rights.

2. Before you start the installation, you need to know if you are running 
the 32-bit version or the 64-bit version of Windows 7 on your computer. 
If you are not sure, you can open the following window:
 
Start > Control Panel > System

Within the line “System type” you can find the information needed.
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3. Connect your 1492-PLTKIT Series E plotter to the system and switch on the 
power. 
Go to “Start > Devices and Printers”. If the driver is already installed, you 
will find your plotter in the list of Printers and Faxes. 

If the driver is not yet installed, then an entry “USB- Printing Support” 
appears in the Unspecified list.
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4. In this case, take the following steps:

Double-Click on the entry “USB Printing Support“.

5. In the new window that appears, choose the tab “Hardware”. 

6. Double-click on the entry “Rockwell 1492-PLTKIT…” in the 
“Device Functions” list. 
Choose the tab “Driver” in the next window.
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7. Click on the button “Update Driver…“. The following window 
appears.
Choose “Browse my Computer for driver software”.

8. Click on “Browse” and select the path Psetup\W7_32 or 
Psetup\w7_64 on your installation CD, depending whether you have a 
32-Bit or 64-Bit version of Windows 7:

9. Confirm with “OK” and then “Next”. The installation starts now.
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10. During the installation the following message appears:
“Windows can't verify the publisher of this driver software”:

Choose “Install the driver software anyway”.

11. After a successful installation Windows issues the following message. 
Press “Close” to complete the installation.

12. Reopen the window “Devices and Printers”. Your plotter should now 
appear in the list of Printers and Faxes.
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Installing a Pen in the Pen 
Station

1. Turn the power on by pressing the “On” button,

2. Press the “Pen Station open/close” button. This will lower the pen 
stations to allow a pen to be placed in the station

3. Follow the pen instructions for use on the 1492-PLOTPEN25 or 
1492-PLOTPEN35 box by: assembling the pen point to ink cartridge, 
shaking pen back and forth to activate ink. 

4. Insert pen into pen station. The default pen station is #1 (closest to 
user.) 

5. Press the “Pen Station open/close” button. This will close the pen 
station, sealing it in place. You are now ready to plot.

Removing a Pen from the Pen Station

1. Press the “Pen Station open/close” button. This will open the pen 
stations to allow a pen to be removed.

2. Remove the pen from the pen station. Place the cap on the pen.

3. Press the “Pen Station open/close” button. This will close the pen 
station.

4. Turn the power off by pressing the “Off ” button.

IMPORTANT It is important only the 1492-PLOTPEN25 or 
1492-PLOTPEN35 pens be installed in the pen station. 
Use of a different pen may result in damage to the pen or 
plotter.
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Plotting with the 
1492-PLOTADPT

The 1492-PLOTADPT allows the user to plot with a standard Sharpie™ 
UltraFine point marker (which can be purchased in various colors). The pen 
station will not hold this accessory, so the next process must be followed:

1. Open ClearTools software.

2. Create the marker layout you desire.

3. In the software, select “Plot,” then “Settings.”

4. Set “Pen selection” to “No.” This will cause the plotter to plot without 
taking a pen from the pen station.

5. Carefully install the 1492-PLOTADPT (with the Sharpie™ pen affixed 
to it) in the arm of the plotter, being careful not to move the plotter arm 
while performing this operation.

6. Begin plotting as usual with the ClearTools software. Note the pen will 
have to be manually removed when you have finished plotting.

Activating the Plotter with 
ClearTools

Introduction
This chapter describes the setup, activation, mapping/calibration of the 
plotter to the printed marker cards, and plotting options while using 
ClearTools. 

Switching to Plot Mode
Before you can plot with ClearTools, the software must be put into “Plot 
Mode” 

1. Select the icon on the toolbar, or go to “File” and 
select “Toggle Plot Mode” 

Note: Plot mode is active when “Plot Mode” is written adjacent to the 
version number or when the following icon in the toolbar appears 

depressed:
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Startup options for Plot Mode 

1. The display in Plot Mode can be set up via the Options window (select 
Tools > Options > Plotter). 

Note: Activate the “Start in Plot Mode” checkbox if Plot Mode is to be 
launched in the program after a restart, when opening an application-file or 
when creating a new project.
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Printing/Plotting Before plotting a card, the card must be calibrated and mapped to the 
plotter. 

Mapping to Plotter: 1. After you have filled out your card as desired, go to File? Print

2. Select the Plotter (1492-PLTKIT Series E) in the “Printer” pull down 
menu 

3. Click “Map” on the print screen. When the following pop up appears, 
select the plotter and click “OK” 

 

Note: Each time a new card is selected it will need to be mapped to the 
plotter
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 General Calibration:  Plot a card with a row of X’s going vertically down the marker tags, and 
with a row going horizontally across the marker tags.
 

-If the X’s are centered on all of the tags, do not change any calibration 
settings and move onto plotting your cards.

-If the X’s are not centered, follow the steps on the next page. 

1. Go to File to Print and select “Calibration” 

2. Select “Zero Points” 

TIP
v
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3. Place a piece of tape over the engraved “+” on the upper left corner of 
the plotter; this is your ideal Zero Point.

4. Select the pen you wish to use for plotting (“No Pen” if you are using a 
Sharpie)

5.  Press “Plot Zero Point” and watch where on the tape the plotter draws 
a “+” in relation to the engraved one on the plotter

6.  If the plotted “+” is above or below the engraved one, adjust the Y 
setting, if it is to the right or left, adjust the X setting

-Increasing X value: Moves the “+” to the right
-Decreasing X value: Moves the “+” to the left
-Increasing Y value: Moves the “+” up
-Decreasing Y value: Moves the “+” down

Note:  Suggested increment of change: 5.0

7. Continue adjusting the settings until the Zero points match, then reprint 
the test card and determine if the calibration is correct.

 Adjusting Marker Type If calibrating the Zero Point does not seem to be effective on a single card 
type, go to File→ Print→ Calibration and select “Adjust Marker Type” to 

�
�

5

TIP
v
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create specific settings for that card. If you are satisfied with your calibration, 
move onto the “Plotting” section. 

1. Go to File→ Print→ Calibration and select “Adjust Marker Type”

 

2. The following screen will appear, verify that the plotter is selected under 
“Options” 

3. Use the Offset X and Offset Y values to adjust the single cards 
calibration

Increase Offset X: Text moves down
Decrease Offset X: Text moves up
Increase Offset Y: Text moves left
Decrease Offset Y: Text moves right

Note: Suggested increment of change: 0.5mm

➋

TIP
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Note:  The directions are based on a vertical card as placed on the 
plotter (see image below) 
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Plotting 1. To plot a card, fill out the card as desired and go to File→ Print

2. Click “Print.” The following window will appear:

3. Verify that the inlay is in the correct position (a), that the card is on the 
right frame (b), and that the correct pen is selected (c). If they are all 
correct, click “Continue Plotting” 

Note: Pen Selection—Select the pen that is to be used in the plotter. If 
“No Pen” is selected, an external pen (i.e. a Sharpie) can be 
used that is not returned to the pen holder. 

Plotting Multiple Cards
Multiples of the same card and multiple different cards can both be plotted in 
the same print session. 

1 2 3 4 5

B. There are five
frames for the cards

A. The inlay position
is indicated by 
whichever number 
is next to the
red bar (position 2
in this case)
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Multiples of the same card: 

1. Create multiple “Pages” of a marker card by right clicking on the bottom 
tab strip in ClearTools and selecting “Insert New Page”
 

2. Fill the multiple pages as desired. Each page can be treated as a different 
Marker Card

3. Go to File→ Print

4.  Select “Single Pages” on the Print Window, and select the desired page’s 
check boxes.
 

5. Select “Print”
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6.  Verify that all the inlay positions are correct, and that the desired pen is 
selected. 

7.  Select “Continue Plotting” 

Note: If you do not want to print five marker cards, or wish to skip a 
frame, deselect the “Use Frame” checkbox located above each 
frame. Any frames not selected will not be plotted upon. 

Note:  When plotting more than five cards in a single plot job, multiple 
“Marker Card Fixture” (see above) windows will appear. Select 
“Continue Plotting” on the first window, but do not on the second 
until the first batch of marker cards are plotted upon and you 
have put new marker cards into the frames. 

➏

➐
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Plotting Multiple Different Cards: 

1. In the Project Explorer window right click and select “Insert New 
Marker Type” to create multiple cards

2. Fill the cards as desired, and go to File→ Print

3. You must map all different cards to the plotter. Do this by clicking a 
card, selecting the plotter from the pull down menu, and clicking “Map”

4. Click “Print”

➊

➌
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5. Verify that all the inlay positions, Marker Card to frame orientations, and 
the pen selection are correct. 

6. Select “Continue Plotting” 
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Notes:
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Operation of Plotter

Chapter Objectives This chapter covers:

• Operation

• ON/OFF Buttons

• Clear Buffer

• Pen Station Open/Close Button

• Stop/View Button

Operation Once you have installed the plotter and connected the power supply and data 
cable, you may switch the potter on.

All settings and commands are entered using the control panel.

ON/OFF Buttons
The ON/OFF buttons are used to activate and deactivate the device. When 
the plotter is switched on, the writing arm moves to the top right-hand corner 
of the labeling area. The green light comes on when the system is ready for use 
and ready to receive data from the PC.

Clear Buffer
If the plotter contains data, the yellow light will come on. You can delete this 
data by first making sure the system is in the stop mode (red light on). The 

IMPORTANT Before switching the device on, please ensure there are no 
objects on the writing/plotting area which might prevent 
the writing arm from moving freely.

Switch Device ON/OFF

Open and close pen 
station to insert/remove 
plotter pen

Manual movement in X 
and Y directions, lower 
the plotter pen

Delete data downloaded from PC

Pause or stop plotter activity
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stop mode is entered by pressing the “Stop” button. Then delete the data by 
pressing the “Clear Buffer” button.

Pen Station Open/Close Button
Pressing the “Pen Station Open/Close” button will operate the pen station. A 
pen must be installed in the bottom location prior to plotting (unless 
ClearTools software has pen selection set to “no,” in which case the pen must 
be installed manually in the plotter arm).

Operation of the pen station is only possible when the system is in the stop 
mode. When the pen station has been opened, you can insert the plotter pens 
into the corresponding storage holders and then re-close the pen station by 
pressing the “Pen Station Open/Close” button again.

You may leave the plotter pens in the pen station because the optimized seal 
largely prevents the pens from drying out. If the storage holders become soiled 
over time, replace them with the 1492-PLOTSERV kit.

Stop/View Button
If the “Stop/View” button is activated while the plotter is in action, the job 
will pause immediately and the plotter pen will recalibrate, return the pen to 
the pen station, and the writing arm will return to the right-hand corner. The 
red light will signal the interruption. Pressing the “Stop/View” button again 
will cause the plotter to continue plotting where it left off. The red light will go 
out.

IMPORTANT Only 1492-PLOTPEN 25 and 1492-PLOTPEN 35 plotter 
pens may be used, as the sealing system is designed 
specifically for these plotter pens.

When using the 1492-PLOTADPT, the ClearTools 
software must be the pen selection set to “No.”

Using other plotter pens and writing instruments may 
damage the device.

IMPORTANT Do not leave the pen station open for extended periods, as 
the pens will dry out.

IMPORTANT Inserting a pen into the writing arm holder by hand can 
result in the writing arm inadvertently moving the writing 
arm and compromise calibration.

After inserting the pen, press the “Stop/View” button 
twice in succession to recalibrate the system.
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Cursor and Pen Up/Down Buttons
The “Cursor” buttons are used to move the writing arm manually in all 
directions.

The “Pen Up/Down” buttons lowers and raises the plotter pen. To raise or 
lower the pen, the system must be in the stop mode.

Open the pen station before using the plotter. Insert the plotter pen into the 
pen station and then close the pen station

IMPORTANT These key functions are not used for normal operation. 
They are intended solely for service functions.
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Notes:



Chapter 4

Troubleshooting and Maintenance

Chapter Objectives This chapter describes how to:

 Troubleshoot the marking system

 Perform routine maintenance

 Clean the plotter pens

 Technical Specifications

Using the Troubleshooting 
Chart

Table 4.A is a troubleshooting chart. This chart lists the most common 
operating problems, probable causes, and steps to correct the problem. If you 
encounter a problem that is not listed in the table, contact 
Rockwell Automation Technical Support at (440) 646-3434, 
options: 3, 2, 4, 2, 5. 

Required Equipment A voltmeter is required for verifying that the correct voltage is supplied to the 
plotter. The voltmeter is also required for verifying the correct 
communications cable configuration.
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Plotter Maintenance The plotter has several sliding surfaces. These surfaces do not require any 
lubrication. However, dust and lint may adversely affect plotter performance. 
Use a dust cover to keep the plotter as clean as possible.

Cleaning Plotter

1. If necessary, clean the plotter with a dry, lint-free cloth or a mild 
cleaning solution. DO NOT use abrasives.

2. If the pen station storage holders (sealing units) are heavily soiled, they 
can be replaced. Order service kit 1492-PLOTSERV. This same service 
kit supplies additional priming surfaces.

Table 4.A  Troubleshooting Chart

Problem Probable Cause(s) Corrective Action(s)

Plotter does not power up. 1. Plotter not plugged in.
2. Improper connection to power 

source.

1. Verify that plotter is plugged in.
2. Verify 110/220 VAC, 50/60 Hz 

voltage at power source.

No communications between plotter and 
computer.

1. Faulty communications cable.
2. Wrong COM or USB port selected.
3. USB plugged in upside down.

1. Check cable connections.
2. Verify cable is plugged into COM or 

USB port selected in ClearTools.
3. If steps 1 and 2 do not restore 

communications, turn off plotter, 
unhook communications cable, 
reboot computer, hookup 
communications cable, turn on 
plotter, and start ClearTools.

Plotter does not properly align text on 
markers.

1. The Plotter is not calibrated 
correctly.

1. Check that plotter is calibrated as 
described in the ClearTools 
manual.

Marker text quality is poor. 1. Defective marker pen or pen is out 
of ink.

2. Incorrect inlay placement.
3. Plotting speed is too fast.

1. Replace marker pen.
2. Check inlay installation per table 

1.C.
3. Reduce plotting speed.
4. Verify items 1 through 3 have been 

corrected. Contact Technical 
Support at (440) 646-3434.

For any other problems, call Technical Support at (440) 646-3434.

ATTENTION

!
Do not use aerosol cleaners, household wall cleaners, or 
anything containing solvents since these may damage 
certain components.

Never oil the mechanical parts of your plotter.
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Removing Sealing Unit from Pen Station

1. Open pen station by pressing the “Open/Close” button.

2. Apply the key (enclosed in the 1492-PLOTSERV) to the sealing unit 
and carefully lift the sealing unit from the holding device.

Inserting and Adjusting Sealing Unit

1. Insert new sealing unit into pen station.

2. Carefully press the sealing unit up to the limit-stop in the aluminium 
tube.

3. Using the key, adjust the sealing unit until the key is parallel with the 
plotter surface. The opening on the side of the sealing unit should be 
centered.

Exchanging Priming Plates (for starting plotter pen)

1. Remove the priming plates by pulling them out sideways.

2. Insert new priming plates by sliding them into the guide on the side of 
the clamping device until the plates fit snugly.

Pen Maintenance 1492-PLOTPEN 25 and 1492-PLOTPEN 35 must be removed from pen 
station, capped tightly and stored in the provided pen holder.
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Technical Specifications
Table 4.B Technical Specifications

Plotter type Flatbed plotter

Maximum plotting area 440 mm x 305 mm (17.3 in x 12 in)

Plotting speed Max. 40 cm/sec. (15.75 in/sec)

Plotter pen 1492-PLOTPEN25, 1492-PLOTPEN35

Ports USB level 1.1

Control language Based on HP-GL 7475A

Buffer 16 MB

Drive Two-phase step motor

Pen station Max. four plotter pens with double seal

Addressable resolution 0.01 mm (0.0004 in)

Repeat accuracy 0.05 mm (0.002 in)

Repeat accuracy after pen change 0.05 mm  (0.002 in) with optimum pen

Power supply type Separate power supply with 
interchangeable adapter plug

Power supply voltage/current Input voltage: 100-240V AC 50~60 Hz
Input current: 0.3 A max. at 220V AC
Output voltage: 24V DC
Output current: 1.4 A max.

Operating temperature 10°…35°C (50°...95° F) at 35%…75% 
relative humidity

Storage temperature -10°…50°C (14°...122°F) at 10%…90% 
relative humidity

Product compliance UL-UL1950
CSA-950
VDE En60950

EMI certification FCC class B
FCC part 15
VDE class B
EN 55022

Dimensions 660 mm x 440 mm x 125 mm (26 in x 17.3 in 
x 5 in)

Weight 8 kg (17.6 lb) (approximately)
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Appendix A

For Plotter Plates with 
Adhesive Strips, 
1492-PLOTPLT, 
Series A

Adhesive Strip Preparation
Before placing any markers on the base plate, carefully remove the five green 
protective coverings from the adhesive strips on the plate. This reveals an 
adhesive surface which aids in holding a marker card when the plotter is 
operating. Remove only the green protective covering, not the blue adhesive 
strip, from the plate.
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